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Intro: Removing E-mail Distractions

TO Remove E-mail distractions [OUTLOOK 2010/2013]:

1.   Click on the File tab.

2.   Click on Options. 

3.   Click on the Mail option. 

4.   Under the Message Arrival section, uncheck all 4 boxes.

5.   Click OK to close.

TO Remove E-mail distractions [OUTLOOK 2007]:

1.   From the menu, click on Tools.

2.   Click on Options. 

3.   Click on the E-mail Options button. 

4.   Click on the Advanced E-mail Options button.

5.   Under the When new items arrive in my Inbox section, 
      uncheck all 4 boxes. 

6.   Click OK three times to close the dialog boxes.
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Intro: Dashboard View Outlook 2010/2013

TO CUSTOMIZE THE RECOMMENDED calendar VIEW, 
YOUR DASHBOARD VIEW [outlook 2010/2013]:

1.   View the Calendar.
2.   In the bottom left corner of the window, click the Folder List icon 

in the Navigation Pane, to display your Folder List.
3.   Click on the HOME tab.  Click the DAY button.
4.   Click the VIEW tab.  Click the TO-DO BAR button and check 

NORMAL, uncheck APPOINTMENTS and uncheck QUICK 
CONTACTS (if showing). [2013: Select TASKS.]

5.   Click the DAILY TASK LIST button and check MINIMIZED.
6.   Place the cursor between the Calendar and To-Do Bar so that 

the mouse pointer turns into bi-directional arrows, and drag the 
To-Do Bar panel to the left to display three months on the top 
right.  *Outlook 2013 monthly calendars may not appear in the 
To-Do Bar panel.  Your calendar will show in the lower left. 

							                 (continued on the next card)
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Intro: Dashboard View Outlook 2010/2013

7.    In the To-Do Bar panel, below the three months, right click on 
the word TASK SUBJECT, or on the words CLICK/TYPE HERE TO 
ADD NEW TASK.  Select VIEW SETTINGS from the menu.  This will 
open an advanced view settings dialog box.  (See image below)

8.   Click the COLUMNS button to change the default column 
      headings:
      a.    Highlight all of the columns in the SHOW THESE
	       COLUMNS IN THIS ORDER list box and click the 
	       REMOVE button. 
	 						                (continued on the next card)
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	 b.	C hange the SELECT AVAILABLE COLUMNS FROM to
			  FREQUENTLY USED FIELDS.  (Scroll to the top of the list to 
			  access).	
	 c.     From the AVAILABLE COLUMNS list box, select the 
              following:  ICON, COMPLETE, ATTACHMENT, SUBJECT, and 
              DUE DATE by clicking on each one and then clicking on the 
              ADD button.
	 d.     Click OK to close the FIELDS dialog box. 
9.   Click the GROUP BY button to show the list, categorized:
	 a.	 Uncheck AUTOMATICALLY GROUP ACCORDING TO 	

	ARRAN GEMENT.
	 b.	 From the Group Items By dropdown menu, select 		

	 Categories. 
	 c.	 Under Expand/Collapse Defaults in the lower right, 	

	 select All Collapsed.
	 d.	C lick OK to close the GROUP BY dialog box.
10.  Click the SORT button to customize how your list displays:
	  a.	      From the Sort Items By dropdown menu, select 
			       Subject for your list to display in alphabetical order, 
			       or Due Date for chronological order.
	  b.	      Click OK to close the SORT dialog box. 
11.  Click the FILTER button to remove flagged items:
	  a.	      Click the Advanced tab.
	  b.	      Highlight the Flag Completed Date option and click 	

		      REMOVE.
	  c.	      Click the FIELD button, select ALL MAIL FIELDS, FLAG 	

		      STATUS, from the drop down menu. 
	  d.	      Click the ADD TO LIST button then click OK to save and 	

		      close the FILTER dialog box.
12.  Click the OTHER SETTINGS button to get flexibility in column 
		  sizing:
	  a.	      Uncheck the top right box AUTOMATIC COLUMN 
			       SIZING and press OK.

Intro: Dashboard View Outlook 2010/2013
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Intro: Dashboard View Outlook 2007

TO CUSTOMIZE THE recommended calendar VIEW, 
YOUR DASHBOARD VIEW [Outlook 2007]:

1.   View the Calendar.
2.   In the bottom left corner of the window, click the Folder List icon 

in the Navigation Pane, to display your Folder List.
3.   Click the DAY tab at the top of the Calendar.
4.   Click VIEW, TO-DO BAR, NORMAL from the menu to turn on the 

To-Do Bar.
5.   Click VIEW, TO-DO BAR and uncheck APPOINTMENTS.
6.   Click VIEW, DAILY TASK LIST and select MINIMIZED.
7.   Place the cursor between the calendar and To-Do Bar panel so 

that the mouse pointer turns into bi-directional arrows, and drag 
the To-Do Bar panel to the left to display three months on the 
top right. 

8.   In the To-Do Bar panel, below the three months, right click on the 
words Arrange By, or on the words Click Here to Add New Task. 
Select CUSTOMIZE CURRENT VIEW from the menu.  This will open 
a View Settings dialog box. 

9.   Click the FIELDS button to change the default field headings:
	 a.     Highlight all of the columns in the SHOW THESE  
              FIELDS IN THIS ORDER list box and click the REMOVE 
              button. 
	 b.     Change the SELECT AVAILABLE COLUMNS FROM to 	
              FREQUENTLY USED FIELDS (Scroll to the top of the list to   
              access).
	 c.     From the AVAILABLE COLUMNS list box, select the 
              following:  ICON, COMPLETE, ATTACHMENT, SUBJECT, and 
              DUE DATE by clicking on each one and then clicking on the 
              ADD button.
	 d.     Click OK to close the FIELDS dialog box. 	 			 

							         (continued on next card)
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Intro: Dashboard View Outlook 2007

10. Click the GROUP BY button to show the list, categorized:
	 a.     Uncheck AUTOMATICALLY GROUP ACCORDING TO 		          	

        ARRANGEMENT.
	 b.     From the Group Items By dropdown menu, select     
	         Categories. 
	 c.     Under Expand/Collapse Defaults in the lower right, select 
	         All Collapsed. 
	 d.     Click OK to close the GROUP BY dialog box.
11. Click the SORT button to customize how your list displays:
	 a.     From the Sort Items By dropdown menu, select Subject 
	         for your list to display in alphabetical order or Due Date    
	         for chronological order.
	 b.     Click OK to close the SORT dialog box. 
12. Click the FILTER button to remove flagged items:
	 a.     Click the Advanced tab.
	 b.     Highlight the Flag Completed Date option and click 
	         REMOVE. 
	 c.     Click the FIELD button, select ALL MAIL FIELDS, FLAG 
	         STATUS, from the drop down menu. 
	 d.     Click the ADD TO LIST button then click OK to save and 
	         close the FILTER dialog box. 
13. To Remove the default task due date:
	 a.     Right click on a task in your Task List, then choose 
	         FOLLOW-UP, SET QUICK CLICK from the menu.
	 b.     Change the setting to NO DATE and click OK. 



7Effective EDGE for Professionals                                          © Effective Edge 2014                                          

Intro: Completed Dashboard View
            Outlook 2010
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Emptying: EDGE System

8
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Emptying: To Do vs. ACTIONS

9

To create a TASK:
1.   Press CTRL + SHIFT + K or double-click in the Task List in the 	
      space that says ‘Click to Add a New Task.’
2.   Fill in the Subject box.
3.   Set a Due Date for the Task, if the task meets the criteria for  
      having a due date.
4.   Select CATEGORY from icon in top ribbon.
5.   Click Save and Close to save your changes to the Task.

The more specif ic  we are,  the faster we can engage with a task.

“Ctrl Shift K will make your day!”

To-Dos vs. Actions
TO-DOs: ACTIONS

Come directly from brain

Specific or vague in nature

No thought process applied

Has dependencies

Examples:

     Training for Marketing

     Clean garage

     Weekly report

Examples:

   E-mail Fred re: training   
   Schedule Saturday with 
     spouse to purge old items  
     in garage
   Measure wall for shelving
   Talk to Joanne re: report    
     format

Action verb at beginning
Can see yourself doing it
Thought process applied
Independent
One sitting to complete
Next strategic step
Specific
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Deciding: EDGE Deciding Model
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Deciding: Where ACTIONS Go

When to use Calendar vs. Task List
CALENDAR TASKS

Time Specific: AT

Example: Lunch Meeting with 

Steve AT 12 pm. 

What: Appointment

How: Type CTRL+SHIFT+A to 
create the apointment.

Due By: BY

Example: Complete survey 

BY December 15th.

What: Task with Due Date

How: Type CTRL+SHIFT+K and 
type the ACTION to create 
the task. Add the due date 

for the item.

Day Specific: ON

Example: John PTO ON Monday

What: All-Day Event

How: Double-click on the date 
at the top of the day and type 

in the ACTION to create an 
All-Day event.

No Due Date: NO

Example: Research new 

computers.

What: Task with NO Due Date

How: Type CTRL+SHIFT+K and 
type the ACTION to create a task.

Just  say “NO” to fake appointments
that actual ly  belong on a task l ist .
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Grouping: Suggested Categories

...Projects:  This category contains the name, description and      
outcome of the project commitment.  Because this is the ‘big picture’ 
for us, we have elevated it to the top of the list by placing ‘...’ in front 
of the word Project.  We all need to be reminded of the ‘big pieces’ 
that we have around us.  For some of us, we may think of them as 
projects, focuses, priorities, etc.  Keeping this list of projects creates 
a reminder for you to keep those big picture goals moving forward. 
Great for any task that has 5 or more steps.

..Actions:  The word Action denotes a generic name for the list of 
actions which you must take.  It represents the very next physical,   
do-able step on an item that you must complete to move forward. 
Your ‘Actions’ list is the main list. 

..Calls:  (OPTIONAL) Many of us spend a significant amount of time 
on the phone.  If this is true for you, then this category may serve 
you well.  “Calls” is a subcategory of ..Actions.  When entering a 
call, enter the person’s name, subject matter, and phone number, 
then categorize the task as ..Calls.

.._________(Insert your Manager’s Name in the blank):  In the 
blank space enter your manager’s name (..Christina).  This is where 
you capture non urgent items to discuss with your manager either in     
person or on the phone. 

..Team:  If you have several team members that you frequently 
speak with, this is a place to capture those non urgent things that 
you need to discuss with them and need to follow up on.  If you 
have regular 1:1s with your team, track items here to discuss.  In 
order for this list to work most effectively, begin each new task 
item with the name or initials of the individual, followed by the task 
description.  This allows you to easily review items when you are                                
talking with each of your team members.
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Grouping: Suggested Categories

..Waiting For:  This category reflects information promised to us by 
someone else.  Until they perform their work and get back to us, we 
cannot move forward with that item.  This allows us to keep a clear 
head about what we can and cannot act on because we are waiting 
for someone else.  Use the name or initials at the beginning of the 
subject line. 

.Errands:  This list represents the stops outside of the home or 
office that you must take.  For instance you can add: “Return shoes 
to department store,” or, “Buy Anniversary card.”

.Home:  This list is made up of actions that we need to take while 
at home.  We frequently are reminded of things that we must do at 
home when we are at the office.  However, we cannot do anything 
about them.  This list helps us to keep focused while at work and 
provides us with one place to look for the things that we need to 
take care of when we are at home. 

.Read/Review:  If your work or life requires significant reading and 
reviewing; whether it’s legal documents, periodicals, magazines, 
internal memos, e-mails and e-mail attachments, etc.; it’s easy to 
become overwhelmed with the sheer volume.  This list allows you 
to log the important reading so that it is distinguished from other   
reading, such as interest & leisure.

.Someday/Maybe:  This category list is for the ideas, future projects 
or “maybe someday I’ll get to that, but not now” list.  It is important 
to keep the ideas and creativity flowing.  However, there is little to do 
with these items except to keep them in an area to ‘incubate.’  There 
is a clear line between this list and all your other lists.  You have not 
committed the time, energy and resources needed to fully deliver on 
this list – at this time. 
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Grouping: Creating Categories

To Set Up New Categories:

1. 	 Press CTRL + Shift + K to create a new task.

2. 	 Click the Categorize button on the Task tab and select the All 
Categories option.

3. 	T o add a new category, click the New button.  Type the name in 
the Category Name text box.  If desired, click on the Color drop 
down-box to assign a color to the Category.  Choose OK to save 
the Category.

4. 	R epeat step 3 for each new Category you wish to add.

5. 	 When all Categories have been entered, uncheck all the boxes 
to the left of the category names and click OK to close the Color 
Category dialog box.  Close the Task by clicking the X in the top 
right corner of the dialog box.  You do not need to save the 
empty task.
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Grouping: Creating Categories

suggested TASK categories:

...Projects				  

..Actions				  

..Calls (optional)			 

..____(Manager’s Name)

..Team	

..Waiting For

.Errands

.Home	

.Read/Review (optional)

.Someday/Maybe

to categorize a task:

1.	 Double-click to open the task.
2. 	C lick the Categorize button on the Ribbon and select the 

Category from the drop-down list.
3. 	I f there’s a real due date, assign the task a due date.
4. 	C lick Save and Close to save your changes to the Task.

-OR-

1.	 Right-click on the task.
2. 	S elect the Categorize option from the menu and select  the 

Category from the drop-down list.
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Grouping: Task List View 
		   Outlook 2010/2013

To Set Up The TASK List view [outlook 2010/2013]:

1.	S elect TASKS from the folder list.

2.	 From the HOME tab, select Simple List from the Current View 
box.

3.	T o customize the view of Tasks, click on the VIEW tab and click 
VIEW SETTINGS. 

4.	T o group the Tasks by Category, click the GROUP BY button.

	a.	 Uncheck the AUTOMATICALLY GROUP ACCORDING TO 
ARRANGEMENT option.

	b.	S elect CATEGORIES from the GROUP ITEMS BY list.  Click the 
ASCENDING radio button to sort in alphabetical order.

	c. 	S elect ALL COLLAPSED from Expand/Collapse Defaults field.

	d. 	C lick OK to close the GROUP BY box.

5.	C lick the SORT button to customize how your list displays:

	a.	 From the Sort Items By dropdown menu, select Subject for 
your list to display in alphabetical order or Due Date for 
chronological order. 

	b.	C lick OK to close the SORT dialog box.

6.	 Click the FILTER button to change the filter settings.

	a.	S elect the ADVANCED tab.

b.	 Under the Define More Criteria section, select the Field 
button and choose All MaiL Fields, Flag Status.

	c.	 Click the Add to List button, then choose OK to close the 
Filter dialog box. Click OK again to close the View Settings 
dialog box.		

									           (continued on next card)
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Grouping: Task List View Outlook 2010

7.	T o turn off the To-Do Bar, choose View, To-Do Bar, Off from the 
menu.

	 *Other recommended views: (View tab > Change View)

		  •  Completed Tasks

		  •  Next 7 days, “What’s coming due in next week?”

		  •  Overdue Tasks
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Grouping: Task List View Outlook 2007

To Set Up The TASK List view [outlook 2007]:

1.	S elect Tasks from the folder list.  Select the Simple List View 
under Current View on Left.

2.	T o customize the view of Tasks, right click on the field heading 
and select CUSTOMIZE CURRENT VIEW from the menu.

3.	T o group the Tasks by Category, click the GROUP BY button.

a.	 Uncheck the AUTOMATICALLY GROUP ACCORDING TO 
ARRANGEMENT option.

	b.	S elect CATEGORIES from the GROUP ITEMS BY list.  Click the 
ASCENDING radio button to sort in alphabetical order.

	c. 	S elect ALL COLLAPSED from Expand/Collapse defaults field.

	d. 	C lick OK to close the GROUP BY box.

4. 	C lick the SORT button to customize how your list displays:
	 a.     From the Sort Items By drop-down menu, select Subject 
	         for your list to display in alphabetical order or Due Date    
	         for chronological order.
	 b.     Click OK to close the SORT dialog box. 

5.	T o filter the Tasks:

a.	I n the Customize View box, click the FILTER button

b.	S elect the ADVANCED tab. 

c.	 Under the Define More Criteria section, select the Field    
button and choose the All Mail Fields, Flag Status options.

	d.	 Click the Add To List button, then choose OK to close the 
Filter dialog box.  Click OK again to close the Customize New 
dialog list. 		
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Grouping: Copying Tasks to Calendar

To COPY a task to the calendar From your          
dashboard view:

1.   Click on the Task and drag and drop it in the calendar.

2.   By default, the Appointment will be today’s date in a                      	
      30-minute increment.  To customize this, double click the 
      appointment and change the date and time.

      (Great for when you want to block time on your calendar to   		
      complete a task)  

To COPY an appointment to a task list from your 
dashboard view:

1.   Click on the Appointment and drag it to the Task List on     	        
      the right and release the mouse button.	

2.   Rename the Task to a specific, Action - oriented task,         	        
      beginning with an action verb.  Give a due date if appropriate.

3.   Delete the existing Appointment if appropriate, to avoid 
      potential confusion and duplicated information. 
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Grouping: Five Steps to Getting the EDGE 
                    on Projects

1.	 Write down the name of the project. 
•	 Open a new Task and write the Project name in subject line.
•	 Change the category of the Task to ...Project.
•	 Add a due date (if there is a real due date).

2.	 Write the desired outcome statement.
•	 A clear statement of what the project will look and feel like 

when completed.
• 	 E + Motion -  We need to be fully engaged.   When we 

add our emotion and hearts, projects move more smoothly 
because we are using our “whole self.”

• 	 Outcome Focus -  We focus on what we want to identify 
with.  The Outcome Statement has the power to draw to us 
what we need.

3.	 Perform a Project Mind Sweep exercise in the Task text box.

4.	I nsert hyperlinks.
	 a.	 Click on Insert.
	 b.	 Click on Hyperlink.
	 c.	S elect the filename that you would like to link to.
	 d. 	In Text Display field, type abbreviated name of file if   	
		      desired.
	 e.	 Click OK. 

5.	C opy the very next ACTION in a new Task item.
	 a.	H ighlight the next action from your Mind Sweep list.
	 b.	 Right-click on the highlighted text and choose Copy.
	 c.	 Minimize the Project Task.
	 d.	 Press CTRL+SHIFT+K to create a new Task.
	 e.	R ight-click in the Subject text box and choose Paste.
	 f.	 Add a due date and category to the Task.
	 g.	 Save and close the action for that project.
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Grouping: Adding Contacts

Save time searching for contact information in the inbox and instead, 
store them for quick and easy reference, in Contacts.

TO CREATE A CONTACT FROM AN E-MAIL:

1.	 From the Inbox, drag the e-mail to the Contacts icon on the 
Navigation pane.  Outlook copies the sender’s name and e-mail 
address to the appropriate text boxes and places the body of the 
e-mail in the Notes text box.

2.	 Find the details you want to store, like their company name, 
in the Notes text box.  Highlight the text and drag it to the              
appropriate field on the Contacts screen.  For example, highlight 
their company name in the Notes text box and drag it to the 
Company text box.  (You don’t have to cut and paste!)

3.	 Repeat the process as necessary to populate the Contact record.

4.	 Highlight the unnecessary text or press Ctrl+A in the Notes text 
box and press the Delete key on the keyboard to clear it out.

5.	 Click Save and Close to save the Contact record.

6.	 Delete or file the e-mail as appropriate.
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Grouping: Adding Notes

Outlook Notes are a great place to store handy reference                   
information that you need to access quickly without having to 
dig through an e-mail folder.  You can store passwords, process             
instructions, bookmarks, templates or checklists in Notes.  Notes can 
only contain text; they cannot contain attachments or graphics. 

To create a note:

1.	 Click the New button in the Notes section or press                   
CTRL + SHIFT + N on the keyboard to create a new Note.

2.	 Enter the title for the Note at the very top of the note. 

3.	 Enter the details in the body of the Note.

4.	 Click the X on the title bar (top right corner of the window) to 
close and save the Note.

TO CREATE A NOTE FROM AN E-MAIL:

1.	 From the Inbox, drag the e-mail to the Notes icon on the          
Navigation pane.  Outlook copies the text of the e-mail into the 
Note. 

2.	 Type a title for the Note on the top line.

3.	 Delete any unnecessary text from the Note.

4.	 Click the X on the title bar (top right corner of the window) to save 
and close the Note.

5.	 Delete or file the e-mail as appropriate.

TO clean THE notes view:
1.    Click VIEW, To-Do Bar, Off

2.    Click VIEW, Reading Pane, Right
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Grouping: E-mail Effectiveness

Below are a few key tips to help make e-mail more effective:

n	Consider whether the best medium is e-mail.  In some instances, 

i.e., urgent, too complex, personnel/confidential issues, too much 

emotion is present or emotion needs to be communicated – then 

it is better to speak face-to-face or use the telephone.  Sometimes 

Instant Messenger services can be used for urgent matters or    

“two minutes or less” communications.

n	Process e-mail periodically rather than constantly.  Practice 

   stretching your batching intervals - 30 Mins, 60 Mins, etc. 

n	Make the Subject Line reflective of the action and subject          

(e.g., Action Requested, FYI or For Your Records).

n	Use CC and Reply All only if absolutely necessary.

n	Be appropriate.  Ask yourself if you could look them in the eye and 

say the same thing.

n	Only include someone in the To line if a response is expected.



Effective EDGE for Professionals                                          © Effective Edge 2014                                          24

Grouping: E-mail Effectiveness

Other good tips include:
n	Identify the players by name (no Dear Sirs: on e-mail).
n	No jargon, acronyms, slang or colloquialisms, especially when 

English might be their second language.
n	Ask for clarification rather than assume.
n	Distinguish between fact and opinion.
n	Do not respond to gossip.
n	Be mindful of what you send, as 
   your e-mail might be forwarded to others.
n	Assume the best intentions of people.
n	Be curious.

n	Avoid blaming.

*Consider picking 
ONE tip to focus on 
each month, and 
enroll your whole         
team at your next 

team meeting. 

“We teach people how to treat us.”

Writing Effective E-mails

P ASS 
“Take time on the front end to save time on the back end.”

n	 Purpose - Why are you sending it?
n	 Actions - What do you want them to do? 
n	 Specifics - How do you want it done and by when?
n Supporting resources - Where are the tools or 

info they need to complete the Action? 

Reminder: Most people scan e-mails. You only have 
8-10 seconds to convey your message.

Momma used to say, “A stitch in time saves nine!”
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Grouping: Instant Messaging
                    Chat Effectiveness

•	 Mute the chime.  Most chat applications provide multiple 
ways for you to be notified of a new conversation.  Opt for the     
pop-up notification over the chime as it is less disruptive.

•	 Show your status.  Reflect your availability in the IM tool 
so that others know your availability.  When necessary and   
appropriate, sign out to help focus on completing work.  
Remember to sign back in. 

•	 Check availability.   Be sure to check the available status of 
the person you want to chat with before you send a message.

•	 Keep conversations short – use the 2 minute rule.  Escalate 
long or complicated conversations to email or phone.  If you are 
sensing tension or a misunderstanding has occurred, switch to 
video chat or phone.  No actions should be requested on IM.

•	 Respect their time.  Just because the recipient’s status was 
marked available doesn’t mean they have time to engage in 
conversation immediately.  Don’t expect an immediate reply.    
If you have something urgent to communicate, the phone is 
your best resource.

•	 Chat professionally.  Even though you are using chat, you are 
still conducting a professional conversation.  Don’t say anything 
in chat that you wouldn’t say in person or in public.  Be succinct, 
but clear in your messages and remember that in electronic 
messages all capital letters is the equivalent of shouting.

•	 Focus - Don’t multi-task.  It’s difficult to have more than one 
successful conversation at a time whether that conversation is 
in person or in a chat window.  Limit your chat conversations to 
one at a time whenever possible.
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Grouping: Meeting Effectiveness

•	 Aim to spend no more than 60% of your day in meetings.  
Decline invites strategically, according to priority. 

•	 Share the agenda and clear desired outcome of the meeting 
before and/or at the start of every meeting. 

•	 Assign someone to track/record actions; distribute within 24 
hours after meeting.

•	 Assign a time keeper, action tracker and facilitator (typically the 
event organizer).

•	 Schedule meetings for no longer than 1.5 hours.  This is the   
longest amount of time that people can focus (if the meeting 
needs to be longer, take breaks every 1.5 hours). 

•	 If meetings frequently start late/run over in your company, ask 

yourself what you can do to help shift that culture. 

When Booking a Meeting:

•	 State the meeting objectives and agenda clearly in the invite. 
•	 Invite the “right” people: key attendees who will contribute and 

can make decisions.  
•	 Talk to the assistants of key players.  Admins know the most 

about their managers’ schedules, and can recommend when the 
most productive meetings can be held.  

•	 Schedule meetings consecutively or in blocks to allow for less 
interruption in the day.  

•	 Allow lead time: giving attendees at least two weeks notice will 
ensure maximum attendance. 

•	 Send a reminder and desired outcome for the meeting the day 
before to further enhance your attendance.
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Grouping: Communication Effectiveness
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Grouping: Creating E-mail Folders
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To add a Folder or Subfolder:

1. 	R ight click on the file folder you want the subfolder to be 
located under.

2. 	S elect NEW FOLDER, type in the name for the new folder, 
and select OK.

An Example:

n	 Consider using PROJECTS and REFERENCE as file cabinet 
‘drawers.’

n	 It is recommended to have no more than 2 tier levels deep 
under each main level folder.

n	 Remember the red dots?  How can you more tightly           
consolidate your folder list?  Look for common themes 
and find a way to group those. 
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Grouping: Data Files Outlook
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Most users have a maximum mailbox limit set by the system     
administrator for their Microsoft Exchange account.  If you have a 
large amount of mail that you need to store, an Outlook Data File 
(PST) allows you to store messages in a separate file that is not part 
of the mailbox.  Please check with your IT department to determine if 
Outlook Data Files are allowed at your company. 

TO create an outlook data file [Outlook 2010]:

1.	 From the mailbox, click on the Home tab and click on the New 
Items button. 

2.	 Select More Items, Outlook Data File from the menu.
3.	 Select a location where you want to store the file, enter a file 

name and click OK.
4.	 Enter a password, if desired, and click OK.

TO create an Outlook data file [outlook 2007]:

1.	 On the File menu, click New.
2.	 Select Outlook Data File.
3.	 Select Microsoft Outlook Personal Folders File (.pst).
4.	 Personal Folders appears in the Folder List.
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Grouping: 4Ds for E-mail Processing
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n	 Delete  or FILE IT

n	 Do  it in 2 minutes or less

n	 Delegate  in writing with specifics and a                 
due date,  then track in ‘waiting for’  task

n	 Defer  to a calendar or task item

To Create an action from an e-mail [Outlook 2007]:
1. 	 Using the EDGE Deciding Model, choose whether the ACTION 

belongs on your CALENDAR (do ON a certain day, and/or AT a 
certain time) or in your TASKS (due BY or NO due date).

2. 	 Right-click on the message and drag it to Calendar or Tasks icon. 
3. 	 Edit the subject line to reflect the ACTION, fill in any detail.
4.	 Click the Categories button on the Ribbon and select the 

desired category for the ACTION.  
5.	 Click Save & Close to save the item.

Effective
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Grouping: 4Ds for E-mail Processing
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To insert an e-mail in an existing task or calendar item:

1. 	 Double-click on the existing Appointment or Task to open the 
item.

2. 	 Click the Insert tab on the Ribbon.

3.	 Click the Attach Item/OUTLOOK ITEM button on the Ribbon.

4. 	S elect the folder the item is stored in.  The list defaults to the 
InBox, but you can change the folder in the Look In list box.  
Select the item you want to be inserted.

5. 	I f you want to see the attachment on your handheld 
device, select Text Only under Insert As, otherwise select         
attachment.

6. 	 Click OK, and the message will appear as an icon or text in the 
appointment or task.

7.	 Click Save and Close to save the changes to the ACTION.

8.	 Delete or file the original e-mail from the Inbox.

To Create a Quick Step Shortcut [outlook 2010/2013]:

1. 	 From the mailbox, click on the Home tab.

2. 	 In the Quick Steps box, click the Create New button.

3. 	 In the Name text box, enter Defer to Task.

4.	 Click the down arrow next to the Actions list and choose Create 
a Task with Attachment from the menu.

5.	C lick the ADD ACTION button.

6.	S elect DELETE MESSAGE from the menu.

7.	 Click Finish. 				       (continued on next card)
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Grouping: 4Ds for E-mail Processing
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To CREATE a Quick Step Shortcut [outlook 2010]:
See screenshot below:
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Grouping: 4Ds for E-mail Processing
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To MANAGE YOUR Quick StepS [outlook 2010/2013]:
See screenshot below:

I t  is  recommended that you remove any default
Quick Steps by select ing the Quick Step and

pressing Delete.
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Grouping: Mailbox Tips Outlook 2010/2013
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Email tips & tricks [outlook 2010/2013]:

To view your inbox by Conversation [outlook 
2010/2013]:
1. 	 From your mailbox, click on the View tab. 
2. 	 In the Conversations group, checkmark the Show As 

Conversations option.  
3. 	 Click the All Folders option to apply the Conversation view to 

all of your mail folders.
4.	 Click the down triangle next to the top level message in the    

conversation to view the conversation thread.  To collapse the 
conversation, click the triangle again.

To Ignore a Conversation [Outlook 2010/2013]:
1.   Click on the Home tab. 
2.   In the Delete group, click on the Ignore button.  The            

conversation and all of its associated messages (previous and 
future) will be moved to the Deleted Items folder.

To Clean Up a Conversation [outlook 2010/2013]:
1.   Highlight your inbox by pressing Ctrl + A. 
2.   Click on the Home tab. In the Delete group, click on the Clean 

Up button and choose Clean Up Conversation.  Any redun-
dant messages (messages whose entire content is contained in 
another message) will be moved to the Deleted Items folder. 

To filter your inbox [outlook 2010/2013]:
1.   Click on the Filter E-mail button on the Home tab.
2.	S elect the type of messages you would like to view.
3.	 Click the Close Search button on the ribbon to return to your 

full mailbox.
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Executing: Beginning the Day Deliberately

“How we start our day can set the tone for our whole day.”

•	 Perform a Mind Sweep.

•	 Review Outlook Today to see what is due today and what 
meetings you have.

•	 Ensure that you are prepared for any meetings              
(i.e., agendas, paperwork, directions, etc.)

•	 Review ..Actions list for any key upcoming actions due.

•	 Set an intention for the day.

•	 Begin the day!

To Set UP OUTLOOK TODAY:

This is your new default view and is a great place to come  
back to after an unexpected interruption.

1.		C lick on the Mailbox folder, typically your email address found   
at the top of folder list.

2.		S elect Customize Outlook Today.

3.		 Check the When starting, go directly to Outlook Today 
option. 

4.		 Change the Show this number of days in my calendar 
option to 1.

5.		 Change the In my task list, show me option to Today’s 
tasks.

6.		 Unselect the Include tasks with no due dates option.   
7.		 Click the Save ChangeS command in the top right corner of   

the screen.
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Executing: Beginning the Day Deliberately

outlook today screenshot [outlook 2007/2010/2013]:
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Executing: Doing & Prioritizing

Doing, the Critical Piece
•	 	 Manage from your lists – not your head.

•	 	R eview lists as frequently as needed to keep work flowing.           

•	 	A cknowledge completion of items and move quickly to the next 

ACTION

•	 	H andle things as they show up – don’t wait until they blow up!

•	 	C reate a mind set that you will get it done!  

•	 	A sk “How can I get this done in 2 minutes or less?”

•	 	 Focus vs. multi-tasking.

Prioritizing & TEST
•	 Use the TEST criteria to make moment by moment choices 

throughout the day:
•	 Time (How much time do you have?)
•	 Energy (How much energy do you have?)
•	 Situation (Location, Context)
•	 Top Level (What is the highest leverage action I can take 

at this moment?)
•	 Capture everything in one place so that you can see and know 

what you have to take care of.  
•	 Ask the question, “Is it actionable?” with each new piece of     

information you receive. 
•	 Take action on items that require 2 minutes or less and delegate 

to remove another 30% to provide quick responses and manage 
the workload. 
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Executing: The Weekly Recharge

PROCESS YOUR NOTES & VOICE MAIL
Review meeting notes, notes scribbled from conversations, 
etc.  Insert any action items (actions, calls, review, waiting fors) 
into the task list as appropriate.

E-mail
Process any outstanding E-mail, leaving your inbox totally 
clear. 

CALENDAR
n 	Prior Week: Review in detail prior week’s calendar. 

Acknowledge completed items!  
n 	Upcoming:  Overview upcoming calendar events – long and 

short term.  Capture any action items needed to prepare for 
upcoming events.  Review upcoming week to ensure 100% 
success can be achieved.  Renegotiate any events or action 
items if necessary.

REVIEW PROJECT LISTS
Evaluate the status of each project, goal and outcome 
ensuring at least one current action item is listed for each. 
Remember, the more you review your outcomes, the greater 
the likelihood that you will achieve them!

								          (continued on next card)
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Executing: The Weekly Recharge

mind sweep
Add to task list any Actions, Projects, Waiting For, Someday/
Maybe, etc., that are in your head using Ctrl Shift K. 

CHeck “none” & “drafts”
E-mail in drafts and uncategorized items on the task list can 
create leaks in the system.  Make sure e-mails have been sent 
and tasks categorized.

REVIEW ACTIONS FROM ALL CATEGORIES
Mark off completed items from each of the task categories 
and drag to completed items folder or delete.  
Review reminders of further action steps to add to the list.     
Celebrate completions!

REVIEW PAPER FILES & SUPPORT FILES
Browse through all work-in-progress support materials to   
trigger new actions.  Remove material no longer needed.

REVIEW “SOMEDAY/MAYBE” LIST
Scan this list to see if there is anything that you are now willing 
to commit the time, energy and resources to achieving.

BE CREATIVE & COURAGEOUS
Any new, wonderful, hare-brained, creative, exciting,     
thought-provoking, risk-taking ideas you are ready to add into 
your system?  Is there anything else you need to be reminded 
about?  If so, add to your system.

NOW GO HAVE FUN!



Appendix: Outlook Quick Keys
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New Task............................................Ctrl + Shift + k

New Mail Message...........................Ctrl + Shift + m

New Appointment.............................Ctrl + Shift + a

New Contact.......................................Ctrl + Shift + c

New Note............................................Ctrl + Shift + n

To save and close an Outlook item...............Alt + s

To highlight all text........................................Ctrl + a

Permanently delete............................Shift + Delete

For additional Quick Keys go to keyword: 
Keyboard Shortcuts in Outlook Help



Appendix: Resources
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More from Effective EdgeTM

Congratulations!  You’ve now experienced the transformational work of 
EDGE for ProfessionalsTM.  Our mission at Effective Edge is to inspire our 
clients by giving them the tools to live their best life.  We also offer programs 
of this quality for teams and leaders that improve productivity and 
accelerate results.  

Individuals
Check out our website at EffectiveEdge.com for more resources to 
support keeping you and your EDGE System, along with your technology, 
going strong.  We offer programs that support you in being more effective 
and efficient in a sustainable way.  

Teams
Collaborating together and delivering results seamlessly can be a challenge.  
We support teams in having effective conversations and constructive 
dialogue, in clarifying roles and responsibilities, driving innovation and 
creativity, and better leveraging their collaboration tools such as Microsoft 
SharePoint – all to get results in less hours with fewer meetings and less 
conflict.

Leaders
Leading through complexity and change while managing oneself can 
challenge even the best leaders.  Through 1:1 coaching and highly tailored 
approaches to maximize leadership effectiveness, we support leaders in 
clarifying and aligning their priorities and their teams’ priorities with the big 
picture.  We also coach executives on decision making, communication and 
getting the most from themselves and those they lead.

Organizations
As advocates for the leaders, the culture and everyone who works for the 
organization, we take a big-picture approach and architect best-in-class, 
highly-customized solutions that support shaping a winning culture that gets 
the right things done at the right time in the right way.

For further information you can reach us at:
Effective Edge, Inc.
800.836.4020
info@effectiveedge.com
www.effectiveedge.com


